CREATING AN EFFECTIVE POSTER

UNC Health Sciences Library  February 14, 2018
Mary White / mw@unc.edu
Barbara Renner / brrenner@email.unc.edu
**ABOUT THE PRESENTERS**

**Mary White**: As the Global Public Health Librarian, Mary provides consultation, training and research support for students, faculty and staff affiliated with the Gillings School of Global Public Health.

**Barbara Renner**: With a PhD in educational research and evaluation methodology and clinical training in Audiology, Barbara Renner is library services evaluation specialist and liaison to the Allied Health Sciences, where she is an adjunct professor.
OVERVIEW

✓ About Poster Presentations [7 min]
✓ Quick Tips & Useful Resources [15 min]
✓ Poster Critique [7 min]
✓ Your Questions (& Answers) [5-10 min]
THINK ABOUT...
WHAT ARE THE DIFFERENCES BETWEEN THESE POSTERS?
WHAT ARE THE DIFFERENCES BETWEEN THESE POSTERS?

Same Space: New Uses
Jim Curtis, Carol Jenkins, and Bob Ladd, Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

- The NTL at UNC-Chapel Hill is undergoing a total renovation in two phases. In the first phase, the floor of study was completed. The library is now a 13,700 square foot facility on a "traditional" floor plan. Silver has been the color of choice throughout the renovation, with a mix of warm and cool tones. The library features an open work area with individual study carrels, group study rooms, and quiet reading areas.

- Inviting Environment
- Single service point for all patrons
- Large open space
- Color scheme that enhances the overall atmosphere
- Comfortable seating
- Natural light from large windows
- Flexible Functionality
- Rooms that can be reconfigured for different events
- Technology integration
- Upgraded Infrastructure
- New HVAC systems
- New lighting fixtures
- New sound system

 Same Space, New Uses: Transforming the Library for the 21st Century
Jim Curtis, Carol Jenkins, and Bob Ladd, Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

- Background
- The Health Sciences Library is undergoing a total renovation in two phases. The first phase is complete. The second phase, which will added 3,500 square feet to the library, is under construction.

- Inviting Environment
- Single service point for all patrons
- Large open space
- Color scheme that enhances the overall atmosphere
- Comfortable seating
- Natural light from large windows
- Flexible Functionality
- Rooms that can be reconfigured for different events
- Technology integration
- Upgraded Infrastructure
- New HVAC systems
- New lighting fixtures
- New sound system

Lessons Learned So Far
- Prepare for unexpected delays
- Be flexible
- Keep communication lines open
- Celebrate small victories

WHY A POSTER?
(VS. PRESENTATION OR PAPER)

- Opportunity for professional engagement
- Visual + Discussion = Poster
- You might have spent a long time on your research, so it can be hard to cut down into something people can understand quickly. That's basically the job of a poster.
- The main point of making a poster is that you want to tell people about your research in a relatively quick bite. To do so, you need to zero on what’s most important about what you did or found.
<table>
<thead>
<tr>
<th>Title</th>
<th>Text</th>
</tr>
</thead>
<tbody>
<tr>
<td>Choose a title that tells people what your research is about.</td>
<td>Keep it as short as you can while still giving a useful explanation of your research.</td>
</tr>
<tr>
<td>Try to catch people’s attention</td>
<td>Not more than 300-800 words!</td>
</tr>
<tr>
<td>Think about why someone who hasn’t done this research should care about it. What will your audience find interesting about it?</td>
<td></td>
</tr>
</tbody>
</table>
CONTENT: SECTIONS YOU COULD INCLUDE

- Title (including author and program affiliation)
- Introduction
- Methods
- Results
- Discussion and Conclusion
- References
- Any tables, figures, and photos
- Your Contact Information
- Grant Acknowledgement Statement/Information
Good Communication?
A minicab driver picks up the radio and calls base.

Cabbie: B52
Base: C5
Cabbie: OK

Passenger: Excuse me, could you explain what that was all about?

Cabbie: I just wanted to know where to pick up my next fare.
FOLLOW THE INSTRUCTIONS... 
...OF YOUR CONFERENCE
QUICK TIPS & USEFUL RESOURCES
UNC HSL LIBGUIDES: DESIGNING EFFECTIVE POSTERS

HTTP://GUIDES.LIB.UNC.EDU/POSTERS

Learn how to design and publish effective posters. This guide includes sections on design elements, the poster design process, and using software to create posters.

- Design Elements
- Design Process
- Using Software

Designing Effective Posters

Welcome! The purpose of Designing Effective Posters is to help you communicate through a poster. This tutorial includes the following sections:

- **Design Elements**: presents criteria for determining the effectiveness of a poster. Use these criteria as guidelines for designing your poster.
- **Design Process**: describes the tasks for creating a poster. Refer to this section for help with planning and carrying out your poster project.
- **Using Software**: describes techniques for creating a poster with software programs, including Microsoft PowerPoint for Windows, PowerPoint for Macintosh, and Adobe InDesign (both Windows and Mac).

This tutorial does not assume any knowledge of poster design or software, though some background in PowerPoint or InDesign would be helpful. The Using Software sections focus on using these programs for creating posters. They do not discuss many features of the programs not specific to creating posters.

Good luck!
Design Elements overview

This section describes elements of an effective poster. It is divided into pages for Content, Design and Layout, and Graphics.

This section also includes a poster evaluation checksheet to help you increase your awareness of and skill in designing posters, along with examples of posters that you can use for evaluation practice.

To learn about design elements, click on the following links to pages within this section:

- Design Elements: Content
- Design Elements: Design and Layout
- Design Elements: Images and Graphics
- Poster Evaluation Checksheet
- Examples
FOLLOW YOUR READERS
TEXT COLORS/BACKGROUND

Dark on light?

Light on dark?
FUN WITH FONTS! (AND FONT SIZE)

Titles

Serif Fonts e.g. Times New Roman & Sans Serif Fonts e.g. Arial

Headers & Main text have different sizes

One style for your title and one for your main text is appropriate. Include no more than two font styles in the poster.

But be consistent with font size and don’t vary too much.

Captions and References can be smaller text size.
MAKE YOUR OWN IMAGES

Smart Art and Shapes!

Just take photos!
(caution: confidentiality)

Excel charts!

Insert a chart or graph in PowerPoint!
- Public Domain
- Creative Commons

**FIND IMAGES**

- Attribution – acknowledge and name the author/creator of the work
- Non-commercial – the work may not be used in a commercial product – i.e. sold for profit
- No Derivative Works – no remixing or editing of the original image/work is allowed
- ShareAlike – remix only if you let others remix whatever is created as a result
FINDING CREATIVE COMMONS IMAGES
IMAGE RESOLUTION

NIH Fogarty

Original image

Pixelated image
# Poster Evaluation Checksheet

Use this checklist to evaluate posters. We suggest assigning points to a poster with the following values: 1= poor; 2= fair; 3=average; 4=good; 5= excellent.

Can you think of other criteria that aren’t on this list? If you do, let us know.

<table>
<thead>
<tr>
<th>Criteria</th>
<th>Rating</th>
<th>Notes (How could this be improved?)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear Purpose</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Relevant and Significant</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Essential</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Organized</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Clear and Concise</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design and Layout</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Alignment</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Balance</td>
<td></td>
<td></td>
</tr>
<tr>
<td>White space</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Consistency</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Headings and Fonts</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Graphics</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Photographs</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Diagrams, Charts, and Artwork</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Create Your Poster

Brainstorm Content

Consider what information is necessary to communicate your message. Remember, you most likely do not need to include all of the information gathered, so choose only the information and graphics pertinent to conveying your message.

Structure Content

Once you’ve decided what information to include in your poster, focus on organizing and arranging your ideas. For this purpose, you may wish to use notecards, or software such as the outliner in Microsoft Word or a mind mapping program such as Mind Manager. Organize the information you want to present into major topics (such as Background, Methods, Results, Conclusions) and subtopics.

For more information on poster content, see the Content page in the Design Elements section of this tutorial.

Layout and Design

A clear visual layout is essential to an effective poster. You may want to start by drawing a rough sketch of your poster in order to get an idea of how you want to arrange text and images. For more information on layout and design, see the Design and Layout page.

Create your poster on a computer

To create your poster on the computer, you need to decide which software you want to use. We recommend Adobe InDesign, which is an excellent page layout program. However, some people have gotten good results using Microsoft PowerPoint, which is more widely available. For more information, see the Using Software section of this tutorial.

Find out more about the Design Process on the LibGuide!
 UNC HSL LIBGUIDES:  
 DESIGNING EFFECTIVE POSTERS  
 HTTP://GUIDES.LIB.UNC.EDU/POSTERS  

Using Software Overview

Using Software

This section describes techniques for creating a poster using Microsoft PowerPoint and Adobe InDesign for Windows and Macintosh platforms.

Some background in PowerPoint or InDesign is helpful but not required. This section does not discuss many features of the programs not specific to creating posters.

To learn software techniques for creating a poster click on one of the following:

PowerPoint 2016 and 2013 for Windows
Powerpoint 2010 for Windows
PowerPoint 2016 for Macintosh
Powerpoint 2011 for Macintosh
Adobe InDesign (Macintosh and Windows)
PowerPoint for Windows versions 2016 and 2013 are very similar.
To specify the dimensions of the poster click the Customize icon under the Design tab. Then click Slide Size.

In the Slide Size dialog box, enter the Width and Height for your poster. For example, a typical poster could be 56'' wide by 36'' high. Be sure that the printer you plan to use is able to print at the size you specify.
Wrapping text around objects like tables, pictures, shapes, charts, and SmartArt graphics is not supported in PowerPoint. Consider multiple text boxes around the object.
PRINTING LARGE POSTERS

• Make sure your printer can print your poster size!

• The maximum page (slide) size in Powerpoint is 56" by 56".

• To create larger posters, check out the LibGuide, the tips to the right, or contact Bob Ladd for more information.

Tips

- If you want a poster that is longer or wider than 56" we suggest that you create your poster at half-size. Then when you print it, print it at 200% size. For example, if you want your finished poster to be 40" by 80", set your poster size to 20" by 40". Then print it at 200%.

- Keep in mind that if you are creating your poster at half-size, everything in it (text, heading, charts, images) will end up being twice as large in your finished poster. So, for example, if you create a title that has a font size of 48 points, in the final poster it will be 96 points.
PRINT A REDUCED SIZE / HANDOUT OF YOUR POSTER

- Click File > Print
- Then select “Full Pages Slides”
- Check the box next to “Scale to Fit Paper”
POSTER CRITIQUES
(AND BETTER EXAMPLES)
CHARTING THE PHARMACEUTICAL EDUCATION LITERATURE: PAST, PRESENT ... AND FUTURE?

K.T.L. Vaughan, M.S.L, University of North Carolina at Chapel Hill Health Sciences Library; William H. Campbell, Ph.D., University of North Carolina at Chapel Hill School of Pharmacy

Objective

This study characterizes major themes and trends in the pharmaceutical education (PE) literature of the past 35 years by analyzing subject headings assigned to a core set of articles from the American Journal of Pharmaceutical Education (AJPE).

Hypotheses

- The PE literature is growing faster than the overall pharmaceutical literature.
- Major themes in the literature can be identified using subject heading analysis (bibliometrics).
- Trends within these themes can be quantified using bibliometrics.
- Publication trends reflect policy and program trends in pharmacy education.
- Trend analysis may predict future areas of PE.

Methodology

- Downloaded citation and subject heading information from International Pharmaceutical Abstracts (IPA).
- Combination of MeSH and domain-specific subject terms.
- Only complete index of AJPE for study period.
- Managed citations using EndNote and RefWorks databases.
- Identified most popular subject headings and categories.
- Graphed trends as a percent of articles per year.

Growth of PE Literature

All three categories of literature (overall, PE, and AJPE) show growth in actual number of articles published over the study period.

The PE literature is growing faster than the overall literature as indexed by IJA.

Curriculum-related publications are the most frequent of all AJPE topics for the entire 35-year period of study.

Technology-related publications appear to increase in a manner consistent with general interest in internet and distance education.

Manpower-related publications peaked during the 1980s, reflecting the nation's priorities for research and expansion in this area.

Clinical pharmacy and 'PharmD' appear to be strongly correlated, but with a lag of 2-3 years. It will be interesting to observe whether these topics continue now that the PharmD debate is resolved.

Topics in the pharmacy education literature appear similar in content and relative frequency to other health professions, although this should be empirically determined through literature analysis.

Major Themes in Pharmaceutical Education

Subject heading analysis identified 906 categories of subjects, with 10,351 total subject headings.

The number and percent of articles containing a subject category was determined. Several subject categories constitute a significant proportion of the overall PE literature from 1970-2005.

Trends

- Curriculum (37%)
- Sociology, economics, and ethics (21%)
- Pharmacy practice (16%)
- Administration (15%)
- Degrees (10%)
- Information processing and literature (10%)

Using Bibliometrics for Literature Analysis

Subject heading analysis ("bibliometrics") works as a tool for quantitatively analyzing themes and trends in a body of literature due to the unique nature of controlled subject headings.

Subject headings describe the "aboutness" of an article more succinctly than an abstract and title. Controlled vocabularies such as MeSH allow for flexibility in free text and uniformity in indexing.

Major Trends in Pharmaceutical Education

Trend #1: Curriculum, Technology, & Manpower

There has been a significant increase in the proportion of articles published on curricular issues in the past 35 years. Surges have occurred around the late 1970s/early 1980s and the late 1990s. In 2004/05, approximately three quarters of AJPE articles were about curricular topics.

Trend #2: International Technology & DE

- Search curriculum OR teach OR learn?
- Search: information processing OR computer OR [Internet OR World Wide Web OR WWW] OR technology NOT (information OR pharmaceutical technology) OR disease learning

Technology is a stable term, at approximately 1% of the literature, while information processing and computers are increasing gradually. Internet/WWW has had a dramatic increase in the last ten years.

Trend #3: Manpower & Personnel Issues

- Search: [Manpower OR personal OR job OR CO] OR [sex OR women OR race] OR [sex OR ethnicity OR Asian OR Hispanic OR Negro OR age]

This thematic area saw a peak in publications in the late 1980s, but has been declining as a proportion of AJPE articles to approximately 2% in 2004-05.

Trend #4: Clinical Pharmacy & the PharmD

- Search: Degree OR [Doctor of Pharmacy OR PharmD] OR [clinical pharmacy OR pharmacy clinical OR pharmaceutics OR pharmacy OR clinical pharmacy OR pharmacist or clinical]

As expected, peaks in interest coincide with the PharmD vs. BPharm debates of the mid-1980s and 1990s. Note that peaks in clinical pharmacy articles happen roughly two years before peaks in PharmD publications.
Charting the Pharmaceutical Education Literature: Past, Present ... and Future?

K.T.L. Vaughan, MSLS, University of North Carolina at Chapel Hill Health Sciences Library; William H. Campbell, PhD, University of North Carolina at Chapel Hill School of Pharmacy

Objective
This study characterizes major themes and trends in the pharmaceutical education (PE) literature of the past 35 years by analyzing subject headings assigned to a core set of articles from the American Journal of Pharmaceutical Education (AJPE).

Hypotheses
1. The PE literature is growing faster than the overall pharmaceutical literature.
2. Major themes in the literature can be identified using subject heading analysis (bibliometrics).
3. Trends within these themes can be quantified using bibliometrics.
4. Publication trends reflect policy and program trends in pharmacy education.
5. Trend analysis may predict future areas of PE.

Methodology
- Downloaded citation and subject heading information from International Pharmaceutical Abstracts (IPA).
- Combination of MeSH and domain-specific subject terms.
- Only complete index of AJPE for study period.
- Managed citations using EndNote and RefWorks databases.
- Identified most popular subject headings and categories.
- Graphed trends as a percent of articles per year.

Growth of PE Literature
All three categories of literature (overall, PE, and AJPE) show growth in annual number of articles published over the study period. The PE literature is growing faster than the overall literature as indexed by IPA.

Major Themes in Pharmaceutical Education
Subject heading analysis identified 896 categories of subjects, with 10,351 total subject headings. The number and percent of articles containing a subject category were determined. Several subject categories constitute a significant proportion of the overall PE literature from 1970-2005.

Curriculum (37%)
- Sociology, economics, and ethics (21%)
- Pharmacy practice (16%)
- Administration (15%)
- Degrees (10%)
- Information processing and literature (10%)

Trends
1. Curriculum, Teaching, & Learning
   - There has been a significant increase in the proportion of articles published on curricular issues in the past 35 years. Surges have occurred around the late 1970s/early 1980s and the late 1990s.
   - In 2004/05, approximately three quarters of AJPE articles were about curricular topics.

2. Instructional Technology & DE
   - Technology is a stable term, at approximately 1% of the literature, while information processing and computers are increasing gradually.
   - Internet/WWW has had a dramatic increase in the last ten years.

3. Manpower & Personnel Issues
   - This thematic area saw a peak in publications in the late 1980s, but has been declining as a proportion of AJPE articles to approximately 2% in 2004-05.

4. Clinical Pharmacy & the PharmD
   - As expected, peaks in interest coincide with the PharmD vs. BPharm debates of the mid-1980s and 1990s. Note that peaks in clinical pharmacy articles happen roughly two years before peaks in PharmD publications.

Using Bibliometrics for Literature Analysis
Subject heading analysis ("bibliometrics") works as a tool for quantitatively analyzing themes and trends in a body of literature due to the unique nature of controlled subject headings.

Subject headings describe the "broadness" of an article more succulently than an abstract and title. Controlled vocabularies such as MeSH allow for flexibility in free text and uniformity in indexing.
WHAT ARE THE DIFFERENCES BETWEEN THESE POSTERS?
WHAT'S WRONG WITH THIS POSTER?

Same Space: New Uses

Jim Curtis, Carol Jenkins, and Bob Ladd, Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

To create a more flexible, user-friendly and self-evident facility an entrance was added on the street side of the building. Introducing curved forms and rich woods softened the interior. The stairs and elevators were re-integrated into an open stairway with floor penetrations allowing visual contact between floors, and admitting natural light to the basement. A café was placed near the street entrance to encourage a sense of community and a place for informal meeting and exchange. A single service point was designed to provide a physical gateway to the library’s services and collections.

The HSL at UNC-Chapel Hill is undergoing a total renovation in two phases, the first of which is completed. The Library is a 90,000 square foot building on a “land-locked” location. To achieve the vision of a learning and teaching library we needed to address significant issues through programming and design. This poster will deal with four themes.

Goal: Keep collections while gaining space for learning, discovery, and technology

The ratio of space usage in the building was reallocated from 45% for collections, 32% for users, and 23% for staff, to 32%, 39%, and 29% respectively. Since the goal was to keep the collections on site while gaining space for learning, discovery, and technology, extensive use was made of compact shelving. 12,000 square feet was converted from housing collections to other purposes.

Furniture “systems” and movable partitions maintain future flexibility. Enclaves to accommodate small meetings were distributed throughout library departments. Support for various learning styles was provided.

Study rooms were enlarged and designed to support group work interacting with technology. Three classrooms provide large group instruction at hands-on workstations, more informal workshops, and teleconferencing. Two computer labs provide access for over 60 individuals. A large space was designed for flexible programming and for exploration, demonstration, research and development involving advanced technology.

Every seat in the library has a connection to the Internet, most hard-wired and powered, some wireless. A new server room supports up to 40 servers.

An emergency generator will support not only life and safety concerns, but keep many of the library’s electronic services running in the event of a power outage.

“Learning technology should be unobtrusively and ubiquitously supportive and it should enable us to re-humanize learning spaces.”

—William J. Mitchell, MIT
What Makes This Better?

Same Space, New Uses: Transforming the Library for the 21st Century

Jim Curtis, Carol Jenkins, and Bob Ladd, Health Sciences Library, University of North Carolina at Chapel Hill; David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

Background

- The Health Sciences Library is undergoing a total renovation in two phases, the first of which is completed.
- Goal: Renovate 90,000 square foot library to achieve the vision of a learning and teaching library.

Space

- Goal: Keep collections while gaining space for learning, discovery, and technology
- Strategy: Extensive use of compact shelving
- 12,000 square feet converted from collections to other purposes

Inviting Environment

- Single service point provides gateway to services and collections
- Unobtrusive technology
- Curved forms and rich woods soften the interior
- Stairs and elevators reintegrated into an open stairway, admitting natural light
- Café added to encourage a sense of community and informal meeting place

Flexible Functionality

- Furniture and partitions maintain future flexibility
- Study rooms support group work interacting with technology; enclaves accommodate small meetings
- Three classrooms for large group instruction at hands-on workstations, teleconferencing
- Two computer labs provide access for over 60 individuals
- Large space for exploring advanced technology

Upgraded Infrastructure

- Every seat has an internet connection, most hardwired and powered, all covered by wireless
- New server room supports up to 40 servers
- Emergency generator keeps many electronic services running in the event of a power outage

Lessons Learned So Far

- Preparation for sudden aggravation
- Staff morale is key
- “Stressed is dessert spelled backwards”
WHAT ARE THE DIFFERENCES BETWEEN THESE POSTERS?

Same Space: New Uses
Jim Curtis, Carol Jenkins, and Bob Ladd
Health Sciences Library, University of North Carolina at Chapel Hill
David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

The Hill at UNC-Chapel Hill is undergoing a total renovation in two phases, the first of which is completed. The Library is a 100,000 square foot building on a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

1. The library's new design is intended to provide a total renovation in two phases, the first of which is completed. The Library is a 100,000 square foot building on a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

2. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

3. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

4. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

5. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

6. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

7. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

8. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

9. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

10. The new Library has a total of 100,000 square feet, providing a total renovation in two phases, the first of which is completed. The Library is a "land locked" location. To achieve the vision of learning, discovery, and technology, the designers and architects worked closely with the students, faculty, and staff to develop an interactive learning environment.

Same Space, New Uses: Transforming the Library for the 21st Century
Jim Curtis, Carol Jenkins, and Bob Ladd
Health Sciences Library, University of North Carolina at Chapel Hill
David Bradford, Cline Design Associates, PA, Raleigh, North Carolina

Background
The Health Sciences Library is undergoing a total renovation in two phases, the first of which is completed.

Goal
The goal of the 50,000-square-foot library is to enhance the quality of a learning and teaching library.

Space
Gain new educational while gaining space for learning, discovery, and technology.

Inviting Environment
Single-service point providing guidance to services and collections.

Flexible Functionality
Flexible and portable workstations embodies flexibility.

Upgraded Infrastructure
Upgraded technology enhances the library experience.

Lessons Learned So Far
Prepare for students' approaches
Have a plan to "hit" or "miss" the mark
"Breadth is essential, centered in focus"
YOUR QUESTIONS?
(AND ANSWERS)
REMEMBER...
THE HEALTH SCIENCES LIBRARY IS ALWAYS HERE TO HELP!

Bob Ladd: As the Media Literacy and Instructional Design Specialist, Bob helps clients through consultations to identify skills, strategies, tools, and techniques, to help bring positive outcomes for graphic, video, and other design projects.

For design or imaging help with your poster, you can fill out a form to request a consult at http://asklib.hsl.unc.edu/ or email Bob Ladd directly at: bob_ladd@unc.edu
MORE TIPS
Prepare to do a Poster

Decide to do a poster

A poster can be an effective means of presentation at meetings, conferences or in a classroom setting. By creating a poster you can communicate your main points in a succinct and visual manner, allowing you to clearly present your research to others and engage your peers in conversation.

Find out the requirements

Different types of poster projects may have different requirements. For instance, if you are preparing a poster for a conference, research the poster submission guidelines. Is there a deadline for submitting your abstract? Do the guidelines include specific requirements for layout or content?

If you are preparing your poster for a class project, read the requirements on your syllabus well before your completed poster project is due.

Choose a Topic

Choose a topic that is not only interesting, but one that you feel can be communicated well in a poster. When choosing a topic for your poster, remember that you will not be able to fit all of your research on the poster and you should therefore choose a topic that allows you to present each of your points clearly and succinctly.

Write an Abstract

If you are preparing your poster for a conference you may be required to present an abstract in which you briefly present your concept in paragraph form. If you are preparing your poster for a conference, check to see if you should follow a specific structure or template.
PHOTO CORRECTION TOOLS IN POWERPOINT
SHAPES AND TEXT TOOLS IN POWERPOINT
ALIGNMENT OF OBJECTS TOOLS IN POWERPOINT

- Insert > Shapes or Images > begin to draw on slide
- Click on object > Format (drawing tools) for formatting options
- Click on both objects while pressing “Ctrl”, and then click Arrange.
ALIGNMENT OF OBJECTS TOOLS IN POWERPOINT

• Insert > Shapes or Images > begin to draw on slide

• Click on object > Right click (on mouse) for formatting options

• Click on both objects while pressing “Ctrl”, and then click Group.